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Color composite image creation of "Shikisai image" by QGIS

Introducing the creation of RGB color composite images using QGIS from "Shikisai" L2
LTOA tile images.L1B VNR can be processed in the same way.
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Color composite image creation of "Shikisai image" by QGIS

If you do not have QGIS installed, please download it below.
The Windows version of the "QGIS Standalone Installer" will install QGIS and GDAL.

The following G-portal site links to the official Quantum-GIS site.
( https://gportal.jaxa.jp/gpr/information/tool )
Tool / Documents > General > Download the Tool “Quantum GIS”

If you are using Linux, Mac OS X, etc., please check the "QGOS installer" page on
the official website below.

https://qgis.org/en/site/forusers/alldownloads.html



Ex.) RGB color composition of L2 LTOA(TOA radiance) tile image (Equal Area Coordinate (EQA))

Here, we will introduce the creation of an RGB color composite image in which the stray light flag is masked on
the L2 LTOA tile image. L1B VNR images with a stray light flag in the high-order bits can be processed in the

same way.
Preparation * Launch QGIS, importing geotiff images
Mask processing - Mask processing on a raster calculator (bit operator)

(stray light flag)

RGB color composition * RGB 3-band color composition

~~

Tile images mosaic

* Tile images mosaic (if needed)

Preparation

1) Launch QGIS

Introduced in QGIS for Windows.
For Windows, open "QGIS X.XX (X.XX: Version)" on your desktop and double-click "QGIS Desktop X.XX.XX (X.XX.XX: Version)"

to launch it.
Alternatively, in the Start menu, click QGIS X (X: Version) to launch it.

The following QGIS initial screen will be displayed.




Ex.) RGB color composition of L2 LTOA(TOA radiance) tile image (Equal Area Coordinate (EQA))

Preparation

2 ) importing geotiff images

G Untitled Project - QGIS

Select “Add Raster Layer” from the toolbar as shown on the pre E“"é}%ﬁ?:lﬁi'ﬁfﬁ? T o
right. >
& ®BE NV,
Browser

C2Y*®e
Layer > Add Layer > Add Raster Layer foortes \

Y Spatisl Bookmai W, Add PostGIS Layers.. Chri+Shift+D
¢ [ Home A5 Add Spatialite Layer.., Carl+ Shifta L
= Giroup M Add M550 Spatial Layer..
. : o o - . B, Add D2 Spatial Layer, uteshifts2
v G Toqale Editing @, Add Oracle Spatial Layer.. Chri+Shift+0
= 5. er Edit T Add/Edit Virtisal Layer.
» O Current dits ) Add WIMS/WHTS Layer... Cari+Shifte W
: : ?: @ Add ArcGrS MapServer Layer..,
— ) Add WIS Layer..

The "Data Source Manager | Raster" screen is displayed as
shown on the right.
Click the button in the red circle.

Ok ik Help

Add 3 bands for RGB color composition.

The full path of the tile image is entered as shown in the red
frame in the figure on the right.

If you select all three, they will be entered separated by "".
Confirm the selected file name and click the "Add" button in
the red circle at the bottom.

Depending on the system environment and tile image, it may
be displayed in black, but this is not a problem at this stage.

® File Fromcal HTTRUE] clous, ele.
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Ex.) RGB color composition of L2 LTOA(TOA radiance) tile image (Equal Area Coordinate (EQA))

Mask processing

2 ) Mask processing (stray light flag)

In the LTOA tile image data, the upper 2 bits of the 16-bit data are
used for the stray light flag. Mask this stray light flag for imaging.

Select "Toolbox" from the toolbar to display it, as shown on the right.

Processing > Toolbox

The "Toolbox" is displayed as shown in the red frame on the right.

Double-click "Raster Calculator" at the bottom of the toolbox.

GDAL > Raster miscellaneous > Raster calculator

() Raster Calculator x
The "Raster Calculator" shown on the right is displayed. [E—
. Tnout layer A
Select the file to be masked from the pull-down menu of the [ 2 rosesea v wssoon -1
. . Mumber of raster band for A
input layer A in the red frame.

Band 1 (Gray)
Thput layer B [optional]

Number of raster band for B [optional]
Nat set
Thput layer G [aptional]

Number of raster band for G [optional]
Nat set
Thput layer D [aptional]

Run az Batch Processe- Run Cloze Help




Ex.) RGB color composition of L2 LTOA(TOA radiance) tile image (Equal Area Coordinate (EQA))

Mask processing

2 ) Mask processing (stray light flag) (continued)

Fill in the following items at the bottom of "Raster Calculator".

* Calculation in gdalnumeric syntax —>
using +-/* or any numpy array

functions
* Set output nodata value -
* Calculated -

Set the mask value with the bit operator
Set "16383" for LTOA tiles and L1B VNR
bitwise_and(A, 16383)

(Attribute image_data_xxxxx_Mask value)

Set "16383”

Enter the output destination and output file
name from the red circle button

Click the "Run" button at the bottom.
Continue to process the remaining two bands in the same way.

The result of masking is displayed.

The tile number for this observation date is an image with data in

the upper right and lower left.

(&} Raster Calculator

Parameters | Loz

Galoulstion in gdalumeric syntax using +-/# or any numpy array functions (is. logical and()}

l bitwise_and(#, 16388)

Set output nodata wvalue [optional]

16383.000000

Qutput raster type

Flot32

p Advanced parameters
Galoulated
GfUsers/  /Documentss/Data/LTOAUS2E WNOE mask tif
| Open output file after runnine algorithm
GDAL/OGR consale call

edal_cale -—calc “bitwise_and(A, 16388)" ~~format GTiff ~—type Float32 ~-NoDataValue 16383.0 -A C:
¥lserc¥ ¥Documents¥Data¥L TOADS2E VN8 if -—A band | —outfile Gif Users/ FDocuments/Data/

Run as Batch Process

LTOA528 WNDS_mask tif
Gancel




Ex.) RGB color composition of L2 LTOA(TOA radiance) tile image (Equal Area Coordinate (EQA))

RGB color composition

4) RGB color composition

Create an RGB color composite image using the masked image.

Select "Merge" from the toolbar to display it, as shown on the right.

Raster > Miscellaneous > Merge

The "Merge" screen is displayed as shown on the right.
Click the red circle button to the right of the item "Input Raster".

As shown in the figure on the right, the "Multiple selection"
screen is displayed.

Select the masked images in the order in which they are assigned
to R, G, and B, and replace them by dragging.

Check the check box on the left.

Click the "OK" button on the right to return to the "Merge" screen.

Setogs Pugins. Vector [EEIS] Dotsbase Web Mesh Progessing Help
H N e \rn» 5% @ | " Raster Calculator B
¥ ] ma 1 % F 4 &

Align Rasters

@ Merge X

Parameters | Log

Tnpust layers =
Girab peaudocolor 1able from first layer

Plaze aach input file into a separate band

(2 Multiple selection *
LTOA0528_VMNO3 [ESRI:53008] Select All
LTOADS28_VNO3_mask [ESRI:S3008]

LTOA0528_VNOS [ESRI:53008] Glear Selection
LTOADS28 VNOS_mask [ESRI:S3008] P g o
LTOAD528_VMNOE [ESRI:53008]

LTOADS28_VMNOS_mask [ESRI:53008] Add File(g)

Add Directory:=-

oK
Cancel
! Multiple selection 4
LTOAO0528 VNO3 [ESRE:53008] Select All
LTOA0528_VMNO5 [ESRI:53008] -
LTOA0S28 VINOE [ESRE53008] Clear Selection

V| LTOA0528 VNO8_mask [ESRE:53008]

V| LTOAD528_VNOS_mask [ESRI:53008] jloss el lection

v | LTOADS28 VMNO3_mask [ESRL:53008] Add File{g)

Add Directary=

Gancel




Ex.) RGB color composition of L2 LTOA(TOA radiance) tile image (Equal Area Coordinate (EQA))

RGB color composition

4 ) RGB color composition (continued)

(2} Merge K
"3 elements selected" is displayed in the input raster item. Fo———
Check ”Place each input file into a separate band". it layers

I 3 elements zelected

Grab pseudocalor table from first layer

From the red circle button on the right side of the item "Merged",

|\f Place each input file into a separate band

. . N Output data type
enter the output destination and output file name. o =
P Advanced parameters
Merged
ClICk the "Run" button at the bottom. Gi/Users/ /Documents/Data/L TOADS28_RGB1it @
V| Open output file after running algorithm
GDALAOGR console call
python -m edal_meree -separate —ot Float32 —of GTiff -0 G/Users/’ FDocuments/Data/LTOADG2E_RGE tif —
. - . IR0 o4 478120588 130A5 08 e ee e e o VBB aaf S AR0S2e210
The RGB color composite image of the LTOA tile image is completed. -
QGIS allows you to change and display the coordinate reference system = —
(CRS) . Run s Batoh Pracess Close Help
Click the red circle in the figure below and select from "Predefined

Coordinate Reference Sysyems".
The figure on the right is an example of EPSG: 4326.

T e
If you saved the file with EPSG: 4326, see the next page as well.



Ex.) RGB color composition of L2 LTOA(TOA radiance) tile image (Equal Area Coordinate (EQA))

RGB color composition

4 ) RGB color composition (continued)

If you want to save the file in another coordinate reference system

(CRS), Select the target layer as shown on the right, right-click and
select "Save As".

Export > Save As

LTOADsZE N

The "Save Raster Layer as" screen shown on the right is displayed.
From the red circle button on the right side of the item "File name",

* g Meer 100K

enter the output destination and output file name. :(St:“%.ﬂ o .
Format GeoTIFF - Create VRT

In the item "CRS", select the CRS to be output from the pull-down or :‘ e Mol DAR R ©

red circle button. oRs Defaut CRS: EPSG:4326 - WGS 34 {O

w Extent (current: layer)

Click the "OK" button at the bottom of the screen. ferh [10DuouesTes
. R Wizst 115470223333 East 1435095058491
CRS conversion is complete.

South | 30000033614

Current Layer Extent Galculste from Layer ~ Msp Ganvas Extent

w Resolution (current: layer)
@ Horizontal |00D584123 Wertical 000208334 Layer Resalution
Columng 4215 Rows  |4200 Layer Size
w | | Greate Options

Frofile | Detfault

V| Add saved fils to map Gancel Help




Ex.) RGB color composition of L2 LTOA(TOA radiance) tile image (Equal Area Coordinate (EQA))

Tile images mosaic

Reference : Mosaic (joining) of RGB color composite images

We will introduce the case of joining adjacent tiles.

Select "Build Virtual Raster)" from the toolbar to display it, as shown
on the right.

Raster > Miscellaneous > Build Virtual Raster

The "Build Virtual Raster" screen is displayed as shown on the right.
Click the red circle button to the right of the item "Inpu layers".

As shown in the figure on the right, the "Multiple selection" screen
will be displayed.
Check the check box on the left side of the image to be mosaicked.

Click the "OK" button on the right to return to the "Build Virtual
Raster" screen.

G *Untitled Project - QGIS
Project Edit View Layer Settings Plugins Vector Database Web Mesh Progessing Help
Yy 3 8 i | o= = Raster Calculator... T
Bx: O 8 s LEORZ @

BRGV.Z®m @

Browser BE

T®O

1 Georeferencer.

Analysis

~ Projections
o &

Miscellaneous * 5 Build Virtual Raster..,

Favorites

xtraction " Raster Information..
b " Spatial Backmarks Extraction B Raster Information

b Z Merge..

* [d] Home Conversion

¥
D:¥

E¥

W, Build Overviews (Pyramids]..

EE Tile index

() Build Virtual Raster w

Parameters Loe
Input layers =
Resolution

fiverage

| Place each input file into a separate band

Allow projection difference

(2} Multiple selection b4

LTOAOS28 RGE [ESRES3008] Select All
LTOA0S29_RGE [ESRES3008]
Clear Selection
Togele Selection
fdd Filelz)---

Add Directary:=+

0]:4
Cancel
() Multiple selection X
I\f LTOADSEB_RGE [ESRI:53008] Select All

V| LTOA0529_RGB [ESRL53008]
Clear Selection

Toeele Selection
#idd File(zj-
Add Directory--+
0] 4

Cancel
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Tile images mosaic

"2 elements selected" is displayed in the input raster item.
Uncheck "Place each input file into a separate band".

From the red circle button on the right side of the item "Virtual
Raster", enter the output destination and output file name
(extension is VRT only).

Click the "Run" button at the bottom.

The LTOA tile RGB color composite mosaic image is complete.

QGIS allows you to change and display the coordinate reference
system (CRS).

Click the red circle in the figure below and select from "Predefined

Coordinate Reference Systems".
The figure on the right is an example of EPSG: 4326.

B Memer 10 3| Rstbon [00° | ¢ Fal(( & erm )@

Flsad esvims s Gosedee | |11ITHEINGIGY | Gowe 1Tetecs | -

Ex.) RGB color composition of L2 LTOA(TOA radiance) tile image (Equal Area Coordinate (EQA))

& Build Virtual Raster

Parameters Log

Thput layers

|2 clements seleoted

Resolution

Average

| Place each input file into & separate band

Allow projection difference
p Advanced parameters
Wirtual
GifUsers/ /Documents/Data/L TOANS28_29_RGE wrt
| Open autput file after running algorithm
GDAL/OGR console call

edalbuildvrt —resolution average -+ nearest —input file_list G¥Users¥

¥pAppData¥local¥Temps

processing_Jac 1ed05fBh 14aaf8214422602d6 210/4 1213 110829 deed88dabida lc2bes ﬁee/bulldvrtlnputFl\es tut C/Userss

/Documents//Data/L TOADS28_29 RGEwrt

Fun as Batch Process=-

Gancel

Glaose Help
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